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Introduction to QGIS

Exploring the Map View

New Project Select feature by value
A . ?
Open Project Pan map

Identify feature

Save Project A Pan map to selection N

(@ nfitled|Project - QGIS
Prdjieq Edit View Layer Settinjs Plugins Vector Raster Database Web Processing |Help

BLEY B89 BPRA BENE 60 -H-oegEEsss-y D
BQV.AM L/ l = gl o

i

Deselect feature

Zoom In

Zoo tolselection

v
Zoom to layer Select feature by

Zoom out . .
Area or single click




Adding panels and toolbars

() *Untitled Project - QGIS

Project Edit View Layer Settings

BmE

[

BQV. 2% W

Manage Layers toolbar

5@@@aﬁ&yﬁaﬁl

Plugins Vector Raster Database Web Mesh MMQGIS SCP Processing Help

U pp P

&0 =0

<§) 12 pXx

Browse your folder and files to add any raster/vector layer

Browser

ORTHO

» [] 2 HydroSAR

» [ Agriculture_basic GIS
~ [9.REDD

] Plannings_activities
(] Random
1 Watershed Mana

4

Layer Order Browser

| ayers
o Bl % T & & AL

v M Nepal_population

& =

Y

5 &

Displays the added raster /vector layer

Check/Uncheck to add
or remove the

Panel/Toolbar

%ZE'G \-ﬁ—lv
QR "R B ‘

Click on empty space

Panels
Advanced Digitizing Panel

Browser (2) Panel

V| Browser Panel

GPS Information Panel
V| Layer Order Panel
Layer Styling Panel

I
V| Layers Panel

Log Messages Panel
Overview Panel
V| Processing Toolbox Panel
Results Viewer Panel
SCP Dock Panel
Eia Search QMS Panel
Spatial Bookmark Manager Panel
Statistics Panel
Tile Scale Panel

Undo/Redo Panel

dvanced Digitizing Toolbar

ttributes Toolbar

ata Source Manager Toolbar

v

v

v

v WDatabase Toolbar
v Digitizing Toolbar
v | [Help Toolbar
v lLabel Toolbar
v

anage Layers Toolbar

Shape Digitizing Toolbar
Vv Snapping Toolbar
v Vector Toolbar
Vv Web Toolbar




Adding Veclllor dqlllq () Data Source Manager | Vector X

F
B Browser Source Type

> LO U n C h Q G |S @ File  Directory «  Database | ' Protocol: HTTP(S), cloud, etc.

- e Encoding Automatic v
|. |< h % | .’1!:_ Mesh
> C IC O n -l- e TO b Delimited Source
* Text Vector Dataset(s) I;es\Day llexercise 1

Bangladesh Populatior.sh €1| ..
&c

> A : d "E GeoPackagg
WINAOW OPEeNns v Options Add Vector data from the di

i:, SpatiaLite

»Click on Vector , PostgreSQL

, MSSQL

»Navigate to the folder , Oracle

tory

Consult ESRI Shapefile driver help page for detailed explanations on option

) doh\202 T\CB Trainings\WOGIT\EEI | Els s\ =G felf= A B R A (o = |

h ‘I‘h . d 1_ . DB%'_ DB2 Name Date modified Type
W ere e exerc Ise O O I M f:'l:fl D Bangladesh_Population.cpg 8/17/2021 515 PM - CPGFile
’ D Bangladesh_Population.dbf &8/17/2021 5:33 PM DEF File

ke '|' = WMS/
* WMTS Population o 8/17/2001 515 PM PRI il
o WES / D Bangladesh_Population.shp 8/17/2021 5115 PM  SHP File I
>Ad d VGCTOI’ f| |e SRR C OV VIRR | | Bangladesh_Population.shx 8/17/2021 515 PM  SHX File

Features . ) .
x| Population.csv 8/17/2021 5112 PM Microsoft Exce

Bangladesh_Population.shp &
. + XYZ ) . -
from Day1\Exercisel




Adding vector data

(2 *Untitled Project — QGIS - X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh MMQGIS Processing Help

NEERRY OPeRPP Q. . BatlOR AaEE#=-J0 - M- H-8-5-0 9 w2 [ Y ® -
a@evecawm @ v - = o = : Qe R w
- - A EFANQREE S

f;%
v Browser [EES] Processing Toolbox B
a <} 5 ° o ° g a O 2 p | A
wo oo Vector data added in the display window Beno e
[ Bang| | o Search...
) ' _E]_ bg (U Recently used
9% T Ok (@ Cartography
f ' Q () Database
0 @ File tools
A ' (@ Interpolation
'o = () Layer tools
@ i @ Mesh
- () Network analysis
% = @ Plots
& - ’ () Raster analysis
Vil (@ Raster creation
o » PR () Raster terrain analysis
' E] I}‘v (@ Raster tools
[ »
Layers @6 (2 Vector creation

@ Vector general
@ Vector geometry
(@ Vector overlay
(@ Vector selection
@ Vector table

(@ Vector tiles

% GDAL

& GRASS

@3 KML tools

% LecoS

S SAGA

o fl & T &~ &0
v| [l Bangladesh Populatioi

f

added layerin the layer panel

»
»
»
»
»
»
»
»
»
»
»
»
»
b () Vector analysis
»
»
»
»
»
»
»
»
»
»
»
»

4 3
a Type to locate (Ctrl+K) | Coordinate| 87.268,22.214 ¥ Scale|1:2871178 ~ | @ Magnifier 100% |3 Rotation 0.0° |3/ v Render & EPSG:4326 @ &3




Exploring atiribute table

> Right click on the added Layer i.e. T T T R W

1 |Bagerhat Bagerhat BAG 3959 1431332
° 2 |Bandarban Bandarban BAN 4479 230569
Bhth n_PopUIqtlon°Shp 3 |Barguna Barguna BRG 1831 775693
4 Barisal Barisal BRS 2785 2207426
» Click on Open Attribute Table
- 5 BNOW In LVerview 6 Bogra Bogra BOG 2920 2669287
Show Feature Count 7 Brahamanb... Brahamanb... BBA 1927 2141745
Copy Layer 8 |Chandpur Chandpur CHA 1704 2032449
Repname Layer 9 | Chittagong Chittagong CHI 5283 5296127
WS UL aunus ! Duplicate Layer 10/Chuadanga Chuadanga CHU 1177 807164
# SpatiaLite L Remave | aver 11 Comilla Comilla COM 3085 1177)666
@ PostGIS
’ N.[SSQL r | 12 Cox's Bazar Cox's Bazar COX 2492 1419260
@ Oracle peieisi=a e — 13 Dhaka Dhaka DHA 1464 5839642
2 DB2 Filter... 14| Dinajpur Dinajpur DIN 3438 2260131
» @ WMS/WMTS Change Data Source... 15 Faridpur Faridpur FAR 2073 1505686
i Vector _Tﬂes Set Layer Scale Visibility... 16/ Feni Feni FEN 928 1096745
v ::: XYZ Tiles
Layer CRS 17 Gaibandha  Gaibandha  GAI 2179 1949274
?‘YEI; & T &~ 7 1 Export 18/ Gazipur Gazipur GAZ 1800 1621562
izls:rtiesm l%iﬁzzﬁﬁ Feauu(_.“reosvvalzam GOP 1490 1060791 : _‘




Exploring attribute table

-
=
=
Invert selection : .
? ‘Orgamze column
. -
Selectall 1 peselect all : : 4Open field calculator
Q Bangladesh_Population — Features Tojal: 65 Fifgered: 64, Selected: 0 :— : x
R = & T E®D 2k B oe
District District 1 Area(Sqkm) Pop 1991 Pop 2001 2
1 |Bagerhat Bagerhat BAG 3959 1431332
2 Bandarban Bandarban BAN 4479 230569
3 |Barguna Barguna BRG 1831 775693
4 Barisal Barisal BRS 2785 2207426
5 Bhola Bhola BHO 3403 1476328
6 Bogra Bogra BOG 2920 2669287
7 Brahamanb... Brahamanb... BBA 1927 2141745
8 Chandpur Chandpur CHA 1704 2032449
9 | Chittagong Chittagong CHI 5283 5296127
10/ Chuadanga Chuadanga CHU 1177 807164
11 Comilla Comilla COM 3085 11771666
12 Cox's Bazar Cox's Bazar COX 2492 1419260
13|Dhaka Dhaka DHA 1464 5839642
14 Dinajpur Dinajpur DIN 3438 2260131

15|Faridpur Faridpur FAR 2073 1505686




Exploring attribute table .. .

RetMoR eme@E=-Jo- - ERefa]sy o v@e  Em v
= oy B Qa® w
- .3> & & & @ % % % # Q Bangladesh_Population — Features Total: 64, Filtered: 64, Selected: 3 — O X
/ N & 3 D P = G
L[] 4 . . . . 4
> S e | e C-I- O fe O -|- U re I n District District 1 Area(>qkm) Pop 1991 Pop_2001

Barisal Barisal BRS 2785 2207426
Bhola Bhola 3403 1476328

attribute table by clicking

Chandpur Chandpur CHA 1704 2032449
Chittagong Chittagong CHI 5283 5296127
O n O n y row 10/ Chuadanga Chuadanga CHU 1177 807164
11/ Comilla Comilla CcoM 3085 4032666
M ° 12 Cox's Bazar  Cox's Bazar COX 2492 1419260
» Deselect by clicking on the i [phda [pua et e
14 Dinajpur Dinajpur DIN 3438 2260131
o 15|Faridpur Faridpur FAR 2073 1505686
Deselect all icon
18 Gazipur Gazipur 1800 1621562
19| Gopalganj Gopalganj GOP 1490 1060791
20 Habiganj Habiganj HAB 2637 1526609
21|Jamalpur Jamalpur JAM 2032 1874440
22/ Jessore Jessore JES 2567 2106996

1]

..
L)
i

T Show All Features




Changing colour of

Layer

-> Properties-> Symbology

<

[l

» O
-0
4
:.l
» E
» 8

M Bangladesh Populatio

vector data

@ Information ~ M Fil
A8 Source M simple fill

& Symbology

(';) Zoom to Layer

,Q Zoom to Selection

2 Show in Overview
Show Feature Count
Copy Layer
Rename Layer

D Duplicate Layer

Q Remove Layer...

"= Open Attribute Table

¢/ Toggle Editing
Eilter...

Change Data Source...

Set Layer Scale Visibility...

Layer CRS
Export

Properties...

Labels

Diagrams

3D View

Source Fields i3

Attributes

(. Layer Properties - Nepal_population | Symbology >
E Single symbol v

Unit | Millimeter v

_1100.0 % |+

Form Opacity

. Color
Joins

. Auxiliary
Storage

-

u@ Actions
L Display

p .
4" Rendering

. Favorites

Variables

E Metadata

—

M Dependencies gradient
plasma

Legend

QGIS Server

T Digitizing » Layer Rendering

Style =

gray 3 fill

hashed black /  hashed black \

Save Symbol | | Advanced ~

OK Cancel Apply Help

M




Changing colour of vector data

5 Single symbol v

> Click on the Symbology tab  EEl | ... |
» Select Simple fill under Fill

0 =h™

and click on the Fill Color

> Change the colors by e - e
choosing from the Palette of R g
the standard color -> click o p—
Apply S




Changing colour of vector data

j Q Layer Properties — Bangladesh_Population — Symbology *

) | = Single Symbol v ‘

7 Information ~ [ Fill |¥|

Simple Fill -

‘1@}_ Source
& Symbology . |E| |E|

€3 Labels
[abc BVER'E
% 3D View Symbol layer type| Simple Fill v ‘

Diagrams [Fill color D ] €.

B Fields Fill style I Solid -le

B8 Attributes Form Stroke color I - .
Tefm Stroke width 10.260000 @ 3 Millimeters ~ | €,

&) Auxiliary Storage Stroke style | Solid Line ML=

&} Actions Join style |‘ Bevel M | &

: x |0.000000 ryj—
® Display Offset | |M1111meters v | EL
. y 1 0.000000 4]
4 Rendering
e Temporal v Enable symbol layer €=, Draw effects

Variables » Layer Rendering

a‘ Metadata v| Style v‘ ‘ OK H Cancel H Apply H Help




Changing colour of vector data

» Click on the Symbology Tab

» Dropdown from Single symbol

to Graduated

» Under Value select Pop_1991

> Select the classification mode

» Change the colors by

choosing from the Palette of

the color ramp -> click Apply v

No Symbols
= Single Symbol

= Categorized

= Graduated

B D, L...a

() Layer Properties — Bangladesh_Population — Symbology X s
= Graduated Select Graduated

(3 Information “ Value 123Popul_1991 £
‘1@_ Source Symbol ‘ I ‘ -
& Symbology Legend format %l - %02 Precision (@ % v JIrim
€3 Labels Color ramp B
€® Masks Classes = Histogram
*», 3 Ve
g 3D View Symbol ~ Values Legend
'I Diagrams v [] 700.00 - 1783.20 700 - 1783

_ v [ 1783.20 - 2866.40 1783 - 2866
E Fields v Il 2866.40 - 3949.60 2866 - 3950

. 3949.60 - 5032.80 3950 - 5033

! Attributes Form j =

Joins

. Auxiliary
ﬂ Storage

32.80 - 6116.00 5033 - 6116
Select the column to be classified
Choose the color

r@ Actions

@ Display
& Rendering
c Temporal

Variables

-

Mode |E. Equal Interval I Classes 5 -
P | | Symmetric Classification
Classify | 5B | = | Delete All Advanced ~

v| Link class boundaries

b Laver Rendering

Style ~

Choose the mode

‘ OK ‘ Cancel Applyl Help I




Changing colour of vector data

» Bangladesh Populatio
v | |700-1783
v [ ]1783 -2866
v 7] 2866 - 3950
v [ 3950 - 5033
v [l 5033 - 6116




Labelling vector data
» Right click on the added Loyer{_{

| Single labels K |

° I ' Information | abel with |abe DISTRICT ~ 1 E |_1

-> Properties-> Labels P e — |
| % Symbology wesn  Choose the Label held el |

Labels

» Dropdown the No labels and ggees

Choose the Font

[ |
: I g" 3D View Lorem Ipsum )11:2772891 ~ |[Q; ¥
[ |
| _|_ s. I I b I . : Source Fields = Text Text
S e e C I n g e q e S - | B8 Attributes Form "2 Formatting Fopt Times New Roman v | €,
: : s Buffer
: Joins @ Backgrour Style Regular MKES
M M ,_, § Auxiliary Storage J Shadow
» Choose the Label field i.e P u&s & B/ &[] &
° ° ® A +* Placement
. | & ctions ) -
" / Rendering Size 6.0000 =KES
. ® Display a
| Points >
District : o — .
: Variables oor
3 il I ——
. a Metadata Opacity _1100.0% |5 €
[ |
[ | 1 -
(2 Layer Properties - Nepal_Population | Labels \ 4 X & Dependencies Type case | No change &
I No labels - |e> Legend Spacng  letter | 0.0000 KEl
—) QGIS Server word | 0.0000 2 EL
Digitizing Blend mode Normal > | €

Apply label text substitutes

If the remove duplicate nodes
option is activated, duplicate

Diagrams

M

—

oK Cancel Apply Help |

3D View



Labelling vector data .5

v []1783 - 2866
v [l 2866 - 3950
v [l 3950 - 5033
v [l 5033 - 6116




Why Project the layer?

» To represent the curved surface of earth on a flat surface
» Coordinates are recorded in a Linear Unit i.e. meter

» Easy to understand and for calculations

* Please note for any analysis (raster/vector) all the layers must have

similar CRS



Projection in QGIS

> Click at the EPSG:4326 € EPSG:4326
at the bottom right of QGIS

> In the Filter tab search WGS
84/ UTM zone 45N -> select the

0oNne

() Project Properties — CRS X

Project Coordinate Reference System (CRS)

No CRS (or unknown/non-Earth projection)
Filter I WGS 84 / UTM zone 45N GI

Recently Used Coordinate Reference Systems

Coordinate Reference System Authority ID
WGS 84 / UTM zone 45N EPSG:32645

4 »

Predefined Coordinate Reference Systems Hide deprecated CRSs

Coordinate Reference System Authority ID
~ [ Projected Coordinate Systems
~ Universal Transverse Mercator (UTM)

QGIS
Server WGS 84 / UTM zone 45N EPSG:32645

» Click Apply and OK © Tnpo RS

WGS 84 / UTM zone 45N = //‘ K
o

WKT (
PROJCRS ["WGES &84 / UTM zone 5
45N", ~
BASEGEOGCRS ["WGS 84",

DATUM["World Geode
tic Swvstem 1984" . b’

‘ancel Apply

Help
\/



Projection in QGIS




Q Save Vector Layer as...

PrOjeC'I'ion in QG IS Ez:]oso;::f;: folder and name youlfile

Format
R, h 1_ | |< 'I'h | m __ File name IT\Bangladesh‘Rﬂugh‘BGD_Populatic-n_UTM.shp X | ..
[]700-1783 |
> Ig ClCK On S Oyer :: []1783 - 2866 Layer CRS Layer name Select the CRS as UTM
B I d h P I 'I'. h :; E iggg : ;322 Styl CRS IPrc-ject CRS: EPSG:32645 - WGS 84 / UTM zon ~
qng q es _ opU q Ion.S 4.5033-6116 Propgrties...
o Encoding UTEF-8 -

- > EXport' > SCIVG Feqtu re As 6 Save only selected features

. W Select fields to export and their export options
> Select CRS and specify the

Save as Layer Definitio Name T}’IJE Replace with dlSpla}’Ed values

Save as QGIS Layer Styl v District Stl‘i.ﬂE

parameters A .
» Give output file name as
BGD_Population_UTM.shp

v/ District 1 String
v| Area(Sqkm) String
v Popul 1991 Integer64 | | Use Range

Select All Deselect All
Replace all selected raw field values by displayed values
v Add saved file to map Cancel Hel,



Projection in QGIS

> Right click on layer ->Properties-> Information and olbserve the

Difference

Before

(-} Layer Properties — Bangladesh_Population — Information

0 Information

“\:\\ Source

%" Symbology
€n Labels
B Masks

ﬁ 3D View

. Diagrams

E Fields

Attributes Form
Joing

ﬂ Auxiliary Storage

r@ Actions

@ Display

2" Renderin

-

Information from provider

Name
Path

Storage
Comment
Encoding
Geometry
CRS
Extent

Unit

Feature
count

Style ~

Bangladesh_Population
DAICIMOD\TO do‘\2021\CB

Trainings\WOGIT\Bangladesh\Exercises\Day

1\exercise 1\Bangladesh_Population.shp

ESRI Shapefile

UTF-8
Polygon (MultiPolygon)
EPSG:4326 - WGS 84 - Geographic

88.0086279860000786,20.5906093480000436 :
92.6803068750000421,26.6345130100000347

degrees
64

OK Cancel | Apply

Helj

After

Q

6 Information
"“\:‘\ Source

%" Symbology
€3 Labels

€D Masks

wg 3D View

.| Diagrams

E Fields

Attributes Form
Joins

’tﬂ Auxiliary Storage

r@ Actions
@ Display
& Rendering
c Temporal

Variables

a‘ Metadata

| =T

} (-2 Layer Properties — BGD_Population_UTM — Information

Information from provider

Name
Path

Source

Storage
Comment
Encoding
Geometry
CRS

Extent

Unit

BGD_Population_UTM

DAICIMOD\TO do'2021\CB
Trainings\WOGIT\Bandladesh\Rough\BGD
Population_UTM.shp

DAICIMODATO do\2021\CB
Trainings\WOGIT\Bangladesh\Rough\BGD_P
opulation_UTM.shp|
layername=BGD_Population_UTM

ESRI Shapefile

UTF-8

Polygon (MultiPolygon)

EPSG:32645 - WGS 84 / UTM zone 45N -
Projected
602055.7026422183262184,2285949.60845
63373588026 :
1089931.2236009379848838,2946730.1474
343012087047

meters

Feature count 64

Style ~

OK Cancel || Apply Help




Calculating area

»Load BGD_Population_UTM.shp (you
created)

»Click on Vector->Geometry Tools ->add
geometry attributes l

»Select Input layer and CRS as Lt:lyer CRS

»Dropdown Added geom info Cllhd select
Save to File |

»>Select the output folder and ncﬂﬂ%mbbr file
=

?)U Multipart to Singleparts...

as BGD_pop_area.shp
15 Plugins Raster Database Web Pi
>RU|1 )| Ep &@ &(-: Geoprocessing Tools 4

Geometry Tools b

Analysis Tools

X Simplify...
+/ Check Validity...
‘v Delaunay Triangulation...

4% Densify by Count...

P Lines to Polygons...
¢~ Polygons to Lines...

b
Data Management Tools ’
b

Research Tools B8 Voronoi Polygons...

Add Geometry Attributes...

Q Add Geometry Attributes

Parameters | Log

‘ Input layer

I C9BGD_Population U1~ @ﬂ X |-

Selected fe”rrule:sé}n LY o the input Layer
Calculate using

Layer CRS 4 .
Added geom info Choose the projection

v Open output file after running algori

Choose the output folder

| 0%

Run as Batch Process. ..

Run

Add
geometry
attributes

This algorithm
computes
geometric
properties of the

Create Temporary Layer

_area.shpll = 2 Imk_l
. '11;,1 Save to GeoPackage...

Save to Database Table...

Change File Encoding (Sys

LALEL WY LLLL
"o w
additianal

Cancel

Help

Close




Calculating area

File with added geometry

Layers

< @ quE.JT_";TQ

BGD pop area
v [l BGD Population UTM
v'[_| Bangladesh Population

Added Area and Peny

Q Added geom info — Features Total: 64, Filtered: 64, Selected: 0
LT E & D
Code rea(Sqgkr Pop 1991

.
L

District

—

Bagerhat
Bandarban
Barguna
Barisal
Bhola

Bogra

Chandpur

L= < T B = Y - L

Chittagong
10/Chuadanga
11|Comilla
12 Cox's Bazar
13/ Dhaka

14| Dinajpur
15/ Faridpur
16|/Feni

17/ Gaibandha
18 Gazipur
19| Gopalganj
20 Habigan;

Brahamanb. ..

District 1

Bagerhat
Bandarban
Barguna
Barisal
Bhola

Bogra

Brahamanb. ..

Chandpur
Chittagong
Chuadanga
Comilla
Cox's Bazar
Dhaka
Dinajpur
Faridpur
Feni
Gaibandha
Gazipur
Gopalganj
Habiganj

&

BAG
BAN
BRG
BRS
BHO
BOG
BBA
CHA
CHI
CHU
CoOM
COX
DHA
DIN
FAR
FEN
GAI
GAZ
GOP

3959
4479
1831
2785
3403
2920
1927
1704
5283
1177
3085
2492
1464
3438
2073

928
2179
1800
1490
2637

1431332
230569
775693

2207426

1476328

2669287

2141745

2032449

5296127
807164

4032666

1419260

5839642

2260131

1505686

1096745

1949274

1621562

1060791

1526609

eter fields

— O X
i =
area perimeter

365044829... 1388488.85...
462666060... 578961.206...
134802513... 447530.677...
222427600... 826620.055...
195412050... 1092119.65...
291444356... 453914.735...
192936907... 382856.071...
147367668... 464714.962...
447466328... 888047.905...
116519498... 248343.570...
309856670... 409063.850...
218608322... 678065.201...
147891104... 339450.319...
346018835... 532788.980...
204631380... 355719.896...
910767293.... 315534.285...
216826496... 340144.164...
182120339... 261541.856...
147796591 ... 288617.978...
259328858... 447161.565...




Calculating area (Sq.Km) using field calculator

[ Akl

(=) BGD_pop_area — Field Calculator ht
~ pop

»Open Atftribute Table -> Click Oty a0 slacted s

V| Create a new field Update existing field

Toggle editingmode * > ——

e Output field name |Area(Sqkm)
°

! Output field type | Decimal number (real) v
Open Field Calculator - e e [Deconlpeer () _

>Give OUTpUT ﬁeld name Ond 'Iype Expression = Function Editor

VB L Q Searc... | Show Help function $area =
»Select Geometry from the Row P Maing  [* L of the

- Geometry current feature. The area

grOU ps _> $qreq glgi_at_"eﬂex calculated by this

function respects both

area
azimuth the current project's

> Type the expression boundary elpsoid setting and

bounds area unit settings. For

_ T bounds height . . .
= H- A 0FNANN)C] ) [ bgﬁd::\:f&th example, if an ellipsoid
Feature Bagerhat v N ’Euger . has been set for the
uirer m i
Preview: 3646.1842328183034 e - pr,qe,d_th,en the -

‘ OK ‘ Cancel Help
——



Calculating area

Q BGD_pop_area — Features Total: 64, Filtered: 64, Selected: 0

Added new field

e

4 & | g - T HE S D PE =5«
District =«  District 1 Code  Pop 1991 area perimeter | Area(Sqkm) =

1 Bagerhat €. Bagerhat BAG 1431332 3650448293.... 1388488.85]. 3646.2
2 Bandarban Bandarban BAN 230569 4626660604.... 578961.206.). 4595.3
3 Barguna Barguna BRG 775693 1348025138.... 447530.677 . 1345.7
4 Barisal Barisal BRS 2207426 2224276003.... 826620.055.]. 2219.6
5 Bhola Bhola BHO 1476328 1954120505.... 1092119.65 ). 1948.5
6 Bogra Bogra BOG 2669287 2914443566.... 453914.735.]. 2912.6
7 Brahamanb... Brahamanb... BBA 2141745 1929369070.... 382856.071.]. 1922.7
8 Chandpur Chandpur CHA 2032449 1473676686.... 464714.962 ]. 1469.4
9 Chittagong Chittagong CHI 5296127 4474663286.... 888047.905 |. 4450.9
10 Chuadanga Chuadanga CHU 807164 1165194983.... 248343.570.]. 1165.1
11 Comilla Comuilla COM 4032666 3098566701.... 409063.850.f. 3088.0
12 Cox's Bazar Cox's Bazar COX 1419260 2186083224.... 678065.201.]. 2173.0
R Maln ITA £030£47 1470AT1AAN rra4En 210 147 1




Joining Atfiributes

> Click ® and select Delimited Text

»Add Population.csv file from
Day1\Exercisel

> Select No geomelry under Geometry
Definition

»You will observe the data under
Sample Data

»Click ADD

Q Data Source Manager | Delimited Text X

B Browser
. ¢ Vvector

ster
5 Raster

, Delimited
Text

f‘+ Spatial.ite
& PostgreSQL
, MSSQL
) Oracle
DB%'_ DB2
\va Virtual
¥ Layer
: WMTS
WES /

+ OGC API -
Features

E; wCs

. XYZ

EEE‘_ Vector Tile

ArcGIS
'}?3_ Map

Service

 ArcGIS

File name F}IT\Bangladesh\Exercises Day 1\exercise 1\Population.csv

Layer name Population Encoding |[UTF-8 v
v File Format
‘@ CSV (comma separated values)
) Regular expression delimiter
) Custom delimiters

v Record and Fields Options

-

Number of header lines to discard 0 Decimal separator is com

| First record has field names Trim fields
v| Detect field types Discard empty fields
v Geometry Definition I

) Point coordinates
_ Well known text (WKT)
‘@' No geometry (attribute only table) Geometry CRS EPSG:4326 -1~

b Layer Settings

Sample Data
District Pop 2001 Pop 2011 Pop 2021
1 |Bagerhat 1549031 1476090 1675000
2 |Bandarban 298120 388335 469000
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Joining Atfiributes

»Right click on layer
BGD pop_area.shp

-> properiies

» Click Joins

>Click on [# sign

»>Select the join layer

»Select the common join and
target field

»Click OK
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rt; Information
‘1@ Source
% Symbology
€™ Labels
e® Masks
ﬁ 3D View

Diagrams

E Fields

W&l Attributes Form

ﬂ Auxiliary Storage
r@ Actions
@ Display
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() Add Vector Join

Join layer

Join field

Target field

v Cache join layer in memory  Select the common join field

4

Select file toke joined

Population

abe District
abe District ‘

Create attribute index on join field

Dynamic form

Editable join layer

Iv v/'| Joined fields I

District
v Pop_2001
v Pop_2011
| Pop_2021

4

Select the common target field

Custom field name prefix

| Cancel I
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District
1 agerhat
2 andarban
3 arguna
4 arisal
5 hola
bgra
rahamanb...

nandpur

L= T I - < T (R I =)

rittagong
10auadanga
11omilla
12px's Bazar
13haka
14inajpur
15aridpur
16:ni
17aibandha
18azipur
19opalganj
20abiganj

Joining Afiributes

@ - F~ .res Total: 64, Filtered: 64, Selected: 0

District 1
Bagerhat
Bandarban
Barguna
Barisal
Bhola

Bogra

Brahamanb. ..

Chandpur
Chittagong
Chuadanga
Comilla
Cox's Bazar
Dhaka
Dinajpur
Faridpur
Feni
Gaibandha
Gazipur
Gopalganj
Habiganj

g

Code
BAG

BAN
BRG
BRS
BHO
BOG
BBA
CHA
CHI
CHU
COM
COX
DHA
DIN
FAR
FEN
GAI
GAZ
GOP
HAB

L T E & D

Pop 1991
1431332

230569

775693
2207426
1476328
2669287
2141745
2032449
5296127

807164
4032666
1419260
5839642
2260131
1505686
1096745
1949274
1621562
1060791
1526609

Export the data as Pop_Joined.shp

ZE =

area

3650448293....
4626660604....
1348025138....
2224276003....
1954120505....
2914443566....
1929369070....
1473676686....
4474663286....
1165194983....
3098566701....
2186083224....
1478911043....
3460188354....

2046313806....

910767293.9...

2168264968....

1821203392....

1477965912....

2593288586....

@

perimeter

1388488.85...
578961.206...
447530.677...
826620.055...
1092119.65...
453914.735...
382856.071...
464714.962...
888047.905...
248343.570...
409063.850...
678065.201...
339450.319...
532788.980...
355719.896...
315534.285...
340144.164...
261541.856...
288617.978. ..
447161.565...

Joined Fie|d—;_

Area(Sqkm)
3646.2
4595.3
1345.7
2219.6
1948.5
2912.6
1922.7
1469.4
4450.9
1165.1
3088.0
2173.0
1476.1
3460.2
2043.7

906.9
2166.6
1817.1
1475.9
25824

| X
Pop 2001 Pop 2011 Pop 2021

1549031 1476090 1675000
098120 388335 469000
f848554 892781 1013000
2355967 2324310 2776000
1703117 1776795 2057000
3013056 3400874 3903000
0398254 2840498 3617000
0271229 2416018 2929000
6612140 7616352 8990000
1007130 1129015 1299000
1595557 5387288 6559000
1773709 2289990 2979000
8511228 120439798000
D642850 2990128 3430000
1756470 1912969 2201000
1240384 1437371 1754000
138181 2379255 2975000
2031891 3403912 4046000
1165273 1172415 1346000
1757665 2089001 2640000




Let’s protect
the pulse.



